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RAbL—=YDWWN Z#®EREL, BELET,

4. OS/HRHFV 7 h7zT7DEA
e OSAVRF—LAFIBIZR->TOSELINFRHY 7 b7 2724V A= LET,
o MHEIZIGLT, WIFNRARTIANREL VR =L LET,



F)B 1. THET L 72 FCH##RRICHE L, PRIMEQUEST 3000 U —X & SAN R b L —3 /FC Z A v
FRA Yy FERERLET,

T—=bFT4R7 (0OS AR F=ILED LUN) 2 X7 LEBIFERATZ2TNTO FC H— FICE
L ET,

sadump DX Y 7T /NA X SAN X b L —VICHRET 25K, £ 7HAKLD LUN % FC h—F
ICEBKL 9,

PRIMEQUEST 3000 > U — X Di2&h7 /3 2 DESIEIL, UEFI %721 Legacy BIOS THEL £ 7



1.3 SAN.7__F£ﬁf}Xn mﬁi%ﬂﬁ

ZI Tl SAN 7 — FIREORIIFOBEFEICOVLWTHAL XS,
e 131 Y RFLBRFABOEEEE
e 132 YRTLEBAROBEEIE
e 133 Y RTFLBAKRDOEEEIE
e 134 ¥ 2T LERBOBEEEIE

131 VRTLRGTEHOEEEIE

PRAT LRGSR, UTORICERL TS,

o MATAHYZFIzTICEL->TEFCED 74 v IDBRIELTHEZNLDHY 9, EADH
2. BTELL X T LR E THEANEEITOET,

e SAN Z b L—=YIZHBEVTEY —NICEY B TET— T4 R7IE, oY —NEBHT 7R &
BRBESICERTDILENHY £F, Inld. FC-Switch oY —=>7 LUN O/ —=>7 <
AEVT FTEENSEZBAEDESLZETERLES ANV - FRETTO7— T 14 R7
LUN &, H=—NERPL=CRETIHLICREIEZ2HRELDY £9),

e sadump DXV 7THAIE, ILAFNRRERTH>TH, ¥V ITINRADREHTT, LE=H->T,
Zy THAPICAZIDPUBIENTEH, D/ SRIGBEICIERY £8A, & THAFHREE TICK
BLEY,

e sadump DX > FHHI%E% ETERNUS EDRIEARY 2 —LTFNA R (v - FREY 3= v FR
Va—L4) ICRET2HEIE. UT2TI5LELHY X,

-DXS2 EFILDFEIE. RBRY 2 —LBEBEXETUTA XD LAFIZEELXT,

DXS3ETFIADHEIE, ¥ - TAEY 3=V RY a—LBREBEETEEYRELET,
MiEZE%* 80% — 100% ICZEBELET,

IO W TIE, TETERNUS Web GUI 2—%—XH 4 F (RBEMR ] #8RBL TS0,

e FCH—F®D SAN 7— bFEENM T TR FEFFMIN/EE, B LIIESAN 77— FEREZIEFIC
SETEIEEICFC XAy TP SAN X L —VEBRIORENEEINHE. AT LBEH
DOBRIZ, UEFIBIOS AALEBICEEBISNBWEESRT LAY Y bEINBZENHYET, 2D
Ay ZYFCH—-FICERINTWD 7 74 "= =TI %R W/ iRRET UEFI BIOS %116 LIS,
BE77AN—T—7L%&ERELSAN 7— FREZBHREL TSI,

o OSEBFERTEFCHA—FOR—FDHRT—FEEZFEMILTLIEE N,

OS BENCFEALABWL (F—%/XR) FC h—FOR— DT — FRENBHICH > TWEHA,
OS A8 L WGEAH Y £,



132 Y RATLBABOREEREE

VAT LEARICIE, UTORICEEBBLTLZE N,
VR F LEARIC, [ServerView Suite BEZIE—E | (JIBHO SVIM ZESZEAZHERLET,
[ServerView Suite BEEE—E]| 1. LUTO Web ¥4 bZSBL TS,

http://www.fujitsu.com/jp/products/computing/servers/primequest/products/3000/0s/svs/

e OS A VR PM—LEEICIE, 7= FTARIUADTARIHDRRRBEVWESICTZHELDY 7,
AVRAE=WVEDT A R SMNERY AL ET, YLFARRBREDBEEE ¥ 7L/ R (FC 7
— TN IEROKZOIER) ICLET, F/o. 7= T A XTI DHE X5 L5 ICETERNUS BITHRET
DREDNHY ET,

133 VRTLEABODEEEIE

PRTLEARICIE, UTORUICERL TSI,
UEFIBIOS TY R T LZEALTHEIE. Y AT LEARICT— 472 3 v % by-path ARERET 2 Z
EEHRLET,
o SAN 7'— b by-path ARFD 7 — b+ 7> 3 VEREFIE
1. RN=FaarviEHd s,
N—=T 4 3 viEshtk, BIOS X = 1 —D[Boot] % 7' A 5 [Boot Option] % #iRT 3,

Information Managenent Boot <F1:Help)

» Boot Options
» Boot From File
» Set Tine Out Ualue

Reset System

2. Boot Option EE T[Add Boot Option] % &R 3,
Infornation | Configuration J| Managenent § Security Gl <F1l:Help

» Add Boot Option
» Delete Boot Option

» Change Boot Order



http://www.fujitsu.com/jp/products/computing/servers/primequest/products/3000/os/svs/

3. File Explorer BiEI T. Fibre @ Disk Volume (X 1 1) % &R 3.

../Fibre(3##55c WWN, ##55E Lun)/...0 (X A4 > {#)Volume % #IRT %
Information @ Configuration @ Management § Security Jill}d <F1:Help

NO UOLUME LABEL,

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0,0x0) /Pc i (0x15,0x0) /Pci (0x0,0x0) /F ibr
e (0x500000E0DA334530, 0x0) /HD (1,GPT, 334B187A-8BCD-4ED2-9DED-T99EE3 ?B43A3.
0x800, 0x100000) 1

Load File

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0,0x0) /Pc i (0xD.0x0) /Pci (0x0, 0x0) /HAC (C
41D46C203EC, 0x1) /TPu4(0.0.0.0,0x0,DHCP,0.0.0.0,0.0.0.0,0.0.0.0)1

Load File

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0,0x0) /Pc i (0xD,0x0) /Pci (0x0, 0x0) /MAC (C
47D46C203EC, 0x1) /TPu6 (0000 : 0000 : 0000 : 0000 : 0000 : 0000 : 0000 : 0000, 0x0, Static
,0000 : 0000 : 0000 : 00OO : 0000 : OOEO : 000V : PO, 0x40, 0000 : A : 00OV : HEOO : 00OA : 0
000 :0000:0000

Load File

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0,0x0) /Pc i (0xD,0x0) /Pci (0x0, 0x1) /HAC(C
41D46C203ED, 0x1) /TPu4(0.0.0.0,0x0,DHCP,0.0.0.0,0.0.0.0,0.0.0.0)1

Load File

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0, 0x0) /Pc i (0xD, 0x0) /Pci (0x0, 0x1) /MAC(C
47D46C203ED, 0x1) /TPu6 (0000 : 0000 : 0000 : 0000 : 0000 : 0000 : 0000 : 0000, 0x0, Static
,0000 : 0000 : 0000 : 00OO : 0000 : OOEO : 000V : PO, 0x40, 0000 : A : 00OV : HEOO : 00OA : 0
000 :0000:0000

Load File

[PcieRoot (0x1) /Pci (0x0,0x0) /Pci (0x0,0x0) /Pc i (0x10,0x0) /Pci (0x0,0x00 /HAC

Enter #EHR L C7/— b7 7 A LZBIRL £ T,
OS DIEFRICL - T, BROBEE., BR7 7 IVIFEGY £7,
5 : Windows D&
[<EFI>]. [<Microsoft>]. [<Boot>]. [bootmgfw.efil ®IEIZEEIRT 5,
% : RHEL7 0i5&
[<EFI>]. [<redhat>]. [shim.efil®IEIZEIRT %,

Infornation | Configuration | Managenent B Security QLY <F1:Help

Infornation @ Configuration § Hanagement @ Security LY <F1:Help>

<.>
<>
<redhat>
<B0OOT>>

Information | Configuration J| Management B Security JEiIId <F1:Help

{0
» BOOTH64.EFI
» fallback.efi




4. Modify Boot Option Description BIfE T. Input the description (Zh — /L% &+ T[Enter]

F-EWLES,
Infornation | Configuration | Management § Security il <F1:Help>

BOOTH64 .EFT

Input the description
Input Optional Data

Comnit Changes and Exit
Discard Changes and Exit

5. Please type in your data BEmI C<<7 — b F 7 a VEIR(X A VA)>>EAHL £,

(7= bF7> 325 5 XFUEZAN)
Information @ Configuration @ Management @ Security EEiLInd <F1:Help>

BOOTX64 .EFI

Input the description
Input Optional Data

Commit Changes and Exit
Discard Changes and Exit

Please type in your data
RHEL?.3 UEFI FC-Main-Path_




Information @ Configuration  Management @ Security I <F1:Help>

BOOTH64 . EFI

Input the description
Input Optional Data

Comnit Changes and Exit
Discard Changes and Exit

Please type in your data
RHEL?.3 UEFI FC-Sub-Path_

6. Modify Boot Option Description Bl ¢. Commit Changes and Exit #&IRETL £,

Information | Configuration | Management | Security
BOOTX64 .EFI

Input the description RHEL?.3 UEFI FC-Main-Path
Input Optional Data _
Connit Changes and Exit
Discard Changes and Exit

Information @ Configuration J§ Management @ Security L%} <F1:Help!

BOOTHO4 .EFT

Input the description RHEL?.3 UEFI FC-Sub-Path
Input Optional Data _

Connit Changes and Exit
Discard Changes and Exit

7. (5)~@)DFIET Fibre DY 7O 7 — b A7 a3 v HERLET,
8. Boot Maintenance Manager EE ¢, Change Boot Order Z:&IRL £9,

Information J| Configuration § Management W Security JEiLilid <F1:Help>

» fidd Boot Option
» Delete Boot Option

» Change Boot Order




9. Change Boot Order BEEIC. Change the order % EIiRT 3,

Information | Configuration jj Management § Security

Change the order <UEFI Misc Device>
<RHEL?.3 UEFI FC-Main-Path>
<RHEL?.3 UEFI FC-Sub-Path>

Commit Changes and Exit
Discard Changes and Exit

10. Change Boot Order BIE T, [+]F¥ — 7 14[-]¥ — %P L T, Boot BEIBLIZ U TICERE L £
Jo
<<KT= b FTavBIR(AA R >>EHRERICRELE T,
<<T=bFT72a v 7TA)>>2 2BBICKEL T,

Information § Configuration M Management W Security G4 <F1:Help

Change the order <UEFI Misc Device>
UEFI Misc Device
RHEL?.3 UEFI FC-Sub-Path
Commit Changes and Exit
Discard Changes and Exit

Information @ Configuration @ Managenent @ Security Ll <F1:Help!

Change the order <UEFI Misc Device>
RHEL?.3 UEFI FC-Main-Path
UEFI Misc Device
RHEL?.3 UEFI FC-Sub-Path

Commit Changes and Exit
Discard Changes and Exit

Information | Configuration | Hanagement § Security

Change the order <UEFI Misc Device>
RHEL?.3 UEFI FC-Main-Path
UEFI Misc Device
RHEL?.3 UEFI FC-Sub-Path
Commit Changes and Exit
Discard Changes and Exit

10



Information J Configuration l Management § Security QG4 <F1:Help>

Change the order

<RHEL?.3 UEFI FC-Main-Path>
RHEL?.3 UEFI FC-Main-Path
RHEL?.3 UEFI FC-Sub-Path

UEFI Misc Device
Commit Changes and Exit

Discard Changes and Exit

11. Change Boot Order BE . Commit Changes and Exit #8RETL £7,

Infornation @ Configuration @ Managenent B Security Gl <F1:Help>|

<RHEL?.3 UEFI FC-Main-Path>
<RHEL?.3 UEFI FC-Sub-Path>
<UEFI Misc Device>

Change the order

Commit Changes and Exit
Discard Changes and Exit

VAT LEEANRIC, UTOBREENH > 735513 FC 1 — MUDREZ ML L BRE 21T - /<&,
BEBZEBRL TSN,

- sadump DX T TFNA X% FC h— RICEHT 2455
- SAN X bL—% - FC XA v FRAIOZREZLE(LUN v Y TDEBR, FA T 74274 — &
R— b=V VEEBH)5T- 1255
- HBREBEETEHTS 0SEUIVERIEBE
LUN /84 ZDBMIZE Y FC H— RAT N, 2 &2 ZFT 2546

FCH— Fo#ffis, 13.1.3 FCH—FREDMHAL] ZSRLTIZE L,

FCH—ROBRTEIE. 3% [3.1.6 HUEFI 0i54)] ,3% [3.2.4 H(legacy DIFAR)| 2SR L
TS,

11



134 VRTLERBOBEEIA

VRTFLEBRBFICE., UTORICERLTIEINL,

1.4

Y—NEREEICIE, ST SAN R L=V EEEB BLUFC X4 v FH5EEIC Ready RREEL > T
Wb ZEEHERLET,

NR=T 4 arHEBREEAIND ETTORMEIL. MMB Web-Ul TEHEL £9,

N=FT 2 T7HERREICEVNT, ARV FATO—FRIT T, N— 7 2 7 OWREMIFEE T
<Y ET, Y—N"EPYUBEX FC h— P - BEE2ET) B, JIRTHLTHE
7,

FC #— FZRFE G & ML 723/E&1d. UEFIL/H:5R BIOS OBRENMKHETT, £72 FC XA v
F/SAN R L —VEBLBEEENVHETT,

SAN 7 — FEREBICBE W T FCREEBOBEBERTICL > TILOS 77— MMIKKT 255505 £,
Z0HE FCRA Yy FESAN R ML —VERET, ERBSLVVRT LOREEZHTD L. HBEEEM
ERELET, €512, MMB Web-Ul @ [Power Control] BIE T [Reset] #%IRL. X T L
THEBLET,

Linux BIBICHEWT, YA F/RREHET SAN 7'— F &4T>TWBHAE, Rescue E— FTREENL .
ETERNUS 7 4 R/ 2 B8~V T 2701217, HOILDFAD FCR—MEITEBEMICL
THLRERETAHLIICLTLIZEL,

NUTFRABROEETIE, ERBICEBTERVW EAHY 7,

o, BEI R BITB-0H, BBV T Y FEITHAWVWEETH, Rescue E— FTRBT 25HE
IZIE. oD LORADFC K- MU ZEMLTHHRBTZ I EEHRELET,

ETERNUS Bt D E

ETERNUS Z##td 2BRICHERFRFEICDOWTEL L. LUTFD Web A b= a7 ILESEL
TLFEEE N,

http://storage-system.fujitsu.com/jp/catalog/manual.html

12


http://storage-system.fujitsu.com/jp/catalog/manual.html

#E 2% Legacy/ UEFIBIOS & E

REDHEMCOVTIE, UTOTZ a7 ALEBBLTIEE L,
FPRIMEQUEST 3000 > U —X ERAEB®EY—/LY 7 7L >»Z(UEFI)] (CA92344-1658)
+ 2.2.2 [PCI Subsystem Configuration] X = 2 —

-+ 2.2.2.1 [OpROM Scan Configuration] X = 2 —
- 2.2.6 [CSM Configuration] * =z —

13



=

3.1

388 7 7AN—=—F ¥ x)AHh—F (16Gbps
/32Gbps FC H— K) O&HTE

FC SAN 77— FEEIEBIZCHEWT, SAN R L —YHEEBE®D LUN O RTLEZREFEE D202,
16Gbps/32Gbps FC A — FTITIREICDOWTHRBL TLWE T,

FC 71—~ ® UEFI 5 A 73k : 11.2.209.2 kit LABE D% E F IR

Z ZTlE. UEFI K5 A /SEREAY 11.2.209.2 FRUBE DR EFIBA B L £ 9,

SAN 77— FERIEICBEWT SAN R L=V B LUN 5 Y R T L% RE S B 256, ¥ AT LIEE
ICERT 2T RTOFCH—FIC LT, UTICHRAT 2RV BETT,

TOBREICLY, BESHESZSAN X FL—VEBDO LUN %2, FCH— RICEHRLET,

Fro, BEIETIRTERRAITHY, PRATLBRBEEICE > TRREINIARIIELR2HBELNDHY &
Jo

e SAN EDT/NA R% sadump DL > 7T NA RICEKRET DA, Hoh Lo UEFI FZ 4
/X £ [Add Boot Device] # Ly LUN ZBINZET 2B H Y £7,

e [Add Boot Device] T&X > 77 /34 Z(LUN) & BIRE L2551k, BESAMNEICARY £
ER

o RVTTNARDEMFREIE, 0S4 >R F—LRICKREL X,
Sadump DF&KE L. [PRIMEQUEST 3000 >~ — XA~ = 2 7 /L] (CA92344-1655)D [£5
58 0S DA R b—ILRICEWET 212 — 5.3 sadump DEFE | H £ O TPRIMEQUEST
3000 YU —XERE®EY — /LY 7 7L > X(sadump, Dynamic Reconfiguration) |
(CA92344-1659) 252 & sadump RIEDHRE] 2B LTSN,

o FCH—FDEREIZ. EF—MIFLITIBLELNHY X7,

o FCH—FDT77—L7zT7HBIPUEFI FZA4NE 12D/ —F7 423 vATERDR
BOREIITEEEA, RBHPVELZHEIE. FCA—FDT77—L7zT7H LT UEFI F
T AR EZNENR—REICHIZ T IZE W,

14



3.1.1. FCH— FDEREAE

Boot X =2 —® [Configuration] 2 7 A5 UEFI KT A NORREEERL 7,
L1 16GbpsFC 51— F(LPe3100x) DFRRMB & 7 . 32GbpsFC 1 — R Di5& 1L [LPe3200x] &%

RENEXY,

1.

2

3

MMB @ [Power Control] EE® [Boot Selector] T [Force boot into EFI Boot Manager] %*

RLT, BREANET,

Boot Manager 7A Y F R—IHAKRENE T,

IR L)W EYAL B Configuration § Securitu

BIDS Revision

» Suystem Informatiom

Systen Date [12/08/20171
Systen Time [16:54:281

Privilege Administrator

[Configuration] % 7 #EIRL £9,

Configuration [QEEEISRAT]

» Onboard Devices Configuration
» PCI Subsystem Configuration

» CPU Configuration

» Memory Configuration

» SATA Configuration

» CSH Configuration

b USB Configuration

» Super I0 Configuration

» UEFI Network Stack Configuratiom
» Power Configuration

b iSCSI Configuration

» Driver Health

» sadump Configuration

» Emulex LightPulse LPe31000-M6 1-Port 16Gh Fibre Ch - FC
» AUAGOD MegaRATD <PRAID EP420i> Configuration Utility - 03.21.14.01
» AUAGD MegaRATD <PRAID EP420i> Configuration Utility - 03.21.14.01

XEXRDI L, Device Manager ICAZEICE LD AEEMAH Y £,

15



EE
UEFI K5 4 /NARE DR IL. [Emulex LightPlus LPe31000-M6 1-port 16G Fibre Ch FC] #3iR L
[Display Adapter Info] 3R L £,

16



3.1.2. FCH— F®D WWN EW§ & & NEE ik

HRERIETDHFCH—FDO WWN 2RERL £,

1. [Configuration] & 7'/ % Device List #3RRx L £ 9,

2. [Emulex LightPlus LPe31000-M6 1-Port 16Gb Fibre Ch -FC]%:&#IR L £ ¥,
(FRI%. Lpe31000-M6 Single port FC 1— K@izt £9)

Configuration REEENSREAN

Onboard Devices Configuration
PCI Subsystem Configuration
CPU Configuration

Memory Configurationm

SATA Configuration

CSM Configuration

USB Configuration

Super I0 Configuration

UEFI Network Stack Configuration
Pouwer Configuration

i3CSI Configuration

Driver Health

»
»
»
»
»
>
>
>
>
>
>
>

sadump Configuration
Enulex LightPulse LPe31000-M6 1-Port 16Gb Fibre Ch - FC
AUAGOD MegaRNID <PRAID EP420i> Configuration Utility - 03.21.14.01

3
3
(3
» AUAGD MegaRAID <PRAID EP420i> Configuration Utility - 03.21.14.01

3. A=Y nEELE<FI>F &R L[WWPN]Z#RL £7,

» sadump Configuration

» Enulex LightPulse LPe31000-M6 1-Port 16Gb Fibre Ch - FC

[ Help 7 Detail 1 : 1/1 page
Fibre Channel HBA WWPN: 10000090FAEE3918

[ HotKeys / ValidKeys 1
F3: Restore Defaults, F10: Commit Settings, Pagellp/Doun: Next/Prev pages

XBE, <FI>*F—%2#8T92 & TCAREEIIFRRERY £7,

17



-3

FC h— FOEHMEHBREICHBITE S &L 512, KRR M4 (PRIMEQUEST 3000 ¥ U —XA#3IT
x330), BEA—F, BHIXOyY MIE, BUSES, BLUDEVESE#XLHRL THEET,
BUS&ES & XAy &SI MMB Web-Ul @ 10U # =2 —_ PCl-Express Slots X =2 —7/»5H, HH
EHBBFCA—FOBUSES 2Ay FESZHERL £7, BUS ES (L. [Seg/Bus/Dev] DIEE D
A7y aTRYIoNIHARDETT, UTICWWNOZHESERLET,

WWW 2 &I
FZ 4 BEH— B PCI FeA=1
(4 — 3 (247) BUS-DEV WWN
0Ox - 00 10 00 00 00 C9 **
Server #1 MC-0JFCxx
0Ox - 00 10 00 00 00 C9 **
0Ox - 00 10 00 00 00 C9 **
Server #2 MC-0JFCxx
0Ox - 00 10 00 00 00 C9 **
AR

e  WWN BERITBICRIICES SAN 77— b XA FLOEBREEBEYE L RTBYETHES
LOEEL TS,

e WWNIBRICERY 2HDE SAN X L= ICERTE R W0, 0S AEEN LA WA & D
BYRELET,

o FCH—FDOBEXN—FY 7 ORSFXEEFIZ. WUNDPEEINDZZEHHY £9,

18



3.1.3. FC 1 — FEREDHIETL
FCh— FEMMIREICR L £ 7,

RS
TIFHEFEEZO FC H— Rzt anTcunwEzIoc, UTOEERFRETT,
BERET AT TS0,

1. [Configuration] # 7'H & Device List #F&/RxL £7,

2. [Emulex LightPlus LPe31000-M6 1-Port 16Gb Fibre Ch -FC]%&&EIR L £,
(FXIZ. Lpe31000-M6 Single port FC h— Fflici ) £37)

3. [Set Emulex Adapter to Default Settings] %33R L. [Enter] ¥—%# L 7,

BTN A Security

001: LPe31000-H6 PCIeB.0Gh/s . xB
LPe31000-H6 Node Name : 20000090FAEE3918
Segi: 00 Bus#: 86 Dev#t: 00 Funcl: 00

Set Boot from SAN <Enable>
» Scan for Fibre Devices
» Add Boot Device
b Delete Boot Dewvice
» Change Boot Device Order
» Configure HBA and Boot Parameters
» Set Emulex Adapter to Default Settings
» Display Adapter Info
» Legacy Only Configuration Settings
» Request RESET or RECOMMECT to Make Changes fActive
b Enulex Firmware Update Utility

2. [Set Adapter Defaults] #Z#IR L. [Enter] ¥—%3FL £,

Configuration [SEEIFERAN

LPe31000-M6 Mode Name : 20000090FAEE3918
Segl: 00 Bust: 86 Dewtt: 00 Funch: 00

» Set Adapter Defaults
» Cancel Set Defaults

3. BEY/N—T4aiavaBERELEIC. [3.1.4BI0S 0FM] ICEATLZE L,

19



3.1.4. BIOS oFE#ht

VAT LEEEFICFCA— FASAN R L —YFKED LUN 238 L. £ Ih o8B TE5L5(1CT
7=, BIOS ZF&IZL £,

1. [Emulex Adapter Configuration Main Menu] X = 2 —#* 5 [Set Boot from SAN] @ <Disable> % &
RLET,

<Disable>F 7=ld<Enable>D&EIRBEE AT RENF T, <Enable> %#IRL. [Enter] ¥—%FL F
.a_c

Information EEENBETTGYAT I Security

001: LPe31000-Mo PCIeB.0Gh/s . =0
LPe31000-M6 Node Mame : 20000090FAEE3918
Segit: 00 Bus#: 86 Dev#: 00 Func: 00

Set Boot from SAN <{Disable>

» Scan for Fibre Devices Disable
» fidd Boot Device Enable

» Delete Boot Device

» Change Boot Device Order

» Configure HBA and Boot Parameters

b Set Emulex Adapter to Default Settings

» Display Adapter Info

» Legacy Only Configuration Settings

» Request RESET or RECOMMECT to Make Changes Active
b Enulex Firmware Update Utility

2. [Set Boot from SAN < Enable >] &¢FRRINTWB Z L ZHERLET,
Configuration [N

001: LPe31000-M6 PCleB.0Gb/s . xB
LPe31000-M6 Node Name : 20000090FAEE3918
Segit: 00 Bust: 86 Devit: 00 Funci: 00

Set Boot from SAN <Enable>
Scan for Fibre Devices

Add Boot Device

Delete Boot Device

Change Boot Device Order

Configure HBA and Boot Parameters

Set Emulex Adapter to Default Settings
Display Adapter Info

Legacy Only Configuration Settings

Request RESET or RECOMNECT to Make Changes Active
Emulex Firmware Update Utility

>
>
>
>
>
>
>
>
>
>

20



3.1.5. Link Speed & Topology MEXE
Link Speed & Topology ME&EAEICOWTHBL E,
B Link Speed DEE X E

THAIEEE D Link Speed (4 Gbps/8 Gbps/16Gbps) (Z& 48 T, Link Speed ZETEHREL £,
¥LPe3200x FC #— FDi5E& 4. (8 Gbps/16 Gbps/32 Gbps) &4l 9,

1. [Configure HBA and Boot Parameters] %3&#R L. [Enter] ¥F—%#L 7,
Configuration [EEENGRAT]

001: LPe31000-H6 PCIeB.0Gh/s . =B
LPe31000-H6 Node Mame : 20000090FAEE3918
Segit: 00 Bus#: 86 Dev#t: 00 FuncH: 00

Set Boot from SAN <Enable>
» Scan for Fibre Devices
» Add Boot Device
» Delete Boot Device
» Change Boot Device Order
» Configure HBA and Boot Parameters
» Set Emulex Adapter to Default Settings
» Display Adapter Info
» Legacy Only Configuration Settings
» Request RESET or RECONMECT to Make Changes Active
» Enulex Firmware Update Utility

EE
[Auto negotiate - Default] ICIZREIZ LA WTLEE W, 25T, BEED Link Speed IZEREL T
LSV, BEREICLAWSES, EBICERLET /N ADPRHEINLWERDY £7,
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1. [Force Link Speed <Auto negotiate - Default>] %33R L. [Enter] ¥—%#ML £,

Configuration QEEEISEA

LPe31000-M6 Node Name : 20000090FAEE3918

» Discard Changes
» Commit Changes
Topology <Point to Point>

PLOGI Retry Timer {Disable - Default>
Force Link Speed {Auto negotiate - Default >
Configure Boot Parameters uto negotiate - Default
4 Gbs/s link speed
Maximum Luns/Target 8 Gb/s link speed
Boot Target Scan Method 16 Gh/s link speed

2. BRI (L TWAFCRA v FEIEFSANX FL—Y&EBE) I2AHE T Link Speed % 4R
L. [Enter] ¥F—%#® L £5,

BT ST Il Security

LPe31000-M6 Node Name : Z0000090FAEE3918

» Discard Changes
» Commit Changes
Topology <Point to Point>
PLOGI Retry Timer <Disable - Default>
Force Link Speed <Auto negotiate - Default >
Configure Boot Parameters Auto negotiate - Default
4 Gb/s link speed
Maximun Luns/Target 8 Gb/s link speed
Boot Target Scan Method 16 Gbhfs link speed

3. [Force Link speed ] #'5%%E L 7= Link Speed TRRENTWE T & =R L X7,

Infornation EEEHISTNGIATI I Security
LPe31000-H6 Node Name : Z20000090FAEE3318

» Discard Changes

b Comnmit Changes
Topology <{Point to Point>
PLOGI Retry Timer <{Disable - Default>
Force Link Speed <16 Gbfs link speed>
Configure Boot Parameters
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4. B/E

. REHIRET D729 [Commit Changes] %3#IR L. [Enter] ¥—%=#L £7,
Infornation EEGIIRTINGAA0)E Security

LPe31000-M6 Node Mame : 20000090FAEE3918

» Discard Changes
» Commit Changes
Topology
PLOGI Retry Timer
Force Link Speed
Configure Boot Parameters

<Point to Point>
{Disable - Default>
<16 Gb/s link speed>

m Topology DX E
Main X = 2 —#* 5 [Configure Advance Adapter Parameters] %33R L [Enter] ¥ — %38 L £,
RE@E |- T [Topology Selection] %R L [Enter] ¥ — %48 L £ 7,
SAN TR & HERD L e (B L 7o E 2 IR L [Enter] ¥ — 230 L £ 9,
Default @ [Autp Topology:Loop first]n SEHZAEISLUT 2SR L T LT L,
Fabric ##: : Fabric Point to Point

FC-AL ##: : FC-AL (MC*0JFCF*/CG*, MC*0JFCM*/CN*ICARZZE L H Y FHA)

pE

SAN 77— rZ1T5L2TDHFC h— RICEKFREZIT>TLLEE L,

B OAEBEDERELE
FCh—FOEEXREICEDE T, WAEMDFCRA Yy FELSANR ML —VEBT AR T LA DK
ELEEICTI2RENHY £,
ETERNUS Z##t3 2 BICHERRTE
TLIZE W,

ICDOWTELLCIE, UTD Web 4 b= aT7ILAESRBL

=Z R

http://storage-system.fujitsu.com/jp/catalog/manual.html
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3.16. 7— FTNNA RDETE

1. [Emulex Adapter Configuration Main Menu] X =2 —7. [Scan for Fibre Devices] &R L.
[Enter] ¥F—%#L £,

Configuration QRIS RAY

001: LPe31000-M6 PCIeB.0Gh/s , xB
LPe31000-M6 Node Mame : Z20000090FAEE3918
Segit: 00 Bus#: 86 Devit: 00 Funci: 00

Set Boot from SAN <Enable>
Scan for Fibre Devices

Add Boot Device

Delete Boot Device

Change Boot Device Order

Configure HBA and Boot Parameters

Set Emulex Adapter to Default Settings
Display Adapter Info

Legacy Only Configuration Settings

Request RESET or RECOMMECT to Make Changes Active
Enulex Firmware Update Utility

b A A A S A . R . 4

2. BRIUIBARING S &, Fibre Device [EHRAERTREINE T,
BIEmEICERE S 2%, TESC] F7z1x [Go to Configuration Main Menu] %33R L. [Enter] F—
L ET,

Configuration RRIEENSRAN

LPe31000-M6 Node Mame : 20000090FAEE3918
Here are the discovered targets:

» Go to Configuration MHain Henu
0001: FUJITSU ETERNUS_DXL 1050

%

Hif59 % Fibre Device BRRENAWEEIE, SAN X FL—YDERE. FC XA v FDERFE.
FEYBERNSEL L AVWAEELRH Y £7,

INOLDREBERLTLIZI W,
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3. [Emulex Adapter Configuration Main Menu] X = 2 —7. [Add Boot Device] %#3%ER L. [Enter]
F—zWLET,

Configuration [REEEREEAN]

001: LPe31000-Mo PCIeB.0Gbs/s . =0
LPe31000-M6 Node Mame : 20000090FAEE3918
Segit: 00 Bus#: 86 Devdt: 00 Funcit: 00

Set Boot from SAN <Enable>
» Scan for Fibre Devices
» Add Boot Device
» Delete Boot Device
» Change Boot Device Order
» Configure HBA and Boot Parameters
» Set Emulex Adapter to Default Settings
» Display Adapter Info
» Legacy Only Configuration Settings
» Request RESET or RECONMECT to Make Changes Active
b Enulex Firmware Update Utility

4. [Scan for Fibre Devices] TRZREL7=Z—7 v kAR RENET, 7— b T/NA( XIEET 5 Fibre
Device #3&IR L [Enter] ¥—%# L £,

Configuration [EEEINSEAN]

LPe31000-M6 Node Name : Z20000090FAEE3918
Here are the discovered targets:

» Go to Configuration Main Menu
» 0001: FUJITSU ETERNUS_DXL 1050

5. BIRL7c&—7 v bICERSIN LUN BRRENE T, Y AT LDEENCEMAT % LUN 28R
L [Enter] ¥—2H L £¥, REEIBEENIRTINET,

Configuration

WUN: S00000E0 DA334520
Here are the discovered LUNs:

» LUN:0000 Mode: Peripheral dev
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6. [Commit Changes] Z®#IR L. [Enter] ¥—%1R LB FEERELIESCIF—%BL £9,

Configuration REEEGEAT]

LUN:0000 Mode: Peripheral dev
LPe31000-H6 Mode Mame : 20000090FAEE3918

» Commit Changes
» Discard Changes

7. [Go to Configuration Main Menu] %2R L. [Enter] ¥—%F L TEAD X =2 —IZEY £7,
RTINS I Security i Boot

LPe31000-M6 Node Name : Z20000090FAEE3918
Here are the discovered targets:

» Go to Configuration Main Menu
» 0001: FUJITSU ETERNUS_DXL 1050

8. sadump DXV T TNA X %eFHHT B5EE. FIE3I hoRKOFIEZITVEML T,

LU TTFNAZREZFFLEWVES, IEBEAEATLEI L,

9. [Emulex Adapter Configuration Main Menu] X =2 —7. [Delete Boot Device] %33R L.
[Enter] ¥—%3L £7, (Z ZTlx [Commit Changes] THRE L7 — b T/NA ZDEFIREED
HROHKLET, )

Configuration

001: LPe31000-M6 PCIeB.0Gb/s , =8
LPe31000-M6 Node Mame : 20000090FAEE3918
Segi: 00 Bus#: 86 Devdt: 00 Funcit: 00

Set Boot from SAN <{Enable>
» Scan for Fibre Devices
» Add Boot Device

» Delete Boot Device

» Change Boot Device Order

» Configure HBA and Boot Parameters

» Set Enmulex Adapter to Default Settings

» Display Adapter Info

» Legacy Only Configuration Settings

» Request RESET or RECOMMECT to Make Changes fActive
» Enulex Firmware Update Utility
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10.

>
>

11.

[Commit Changes] TREL7T7T— b TFNA ZAMRBEFREINTWEIZ L AFERLET,

LT of)T ik WWN : 500000E0 DA334520 2 —4" v b IZ#EE & 7= LUN 0000 =H#EER L £ ¢,
¥LUNNo ld <F1> 2 T3 252 CHEREkET, (BE <FI>2W T332 THERREAY F
ED)

Configuration [EESRAT

LPe31000-H6 Node Mame : Z20000090FAEE3918

01: WUN:500000E0 DA334520 <KEEP>
02: WUN:00000000 00000000 <KEEP>
03: WUN:00000000 DOOOOOOO <KEEP>
04: YUN:00000000 00000000 <KEEP>
05: WUN:00000000 DOOOOOOO <KEEP>
06: WUN:00000000 00000000 <KEEP>
07: WUN:00000000 00O0OOOO <KEEP>
08: WUN:00000000 0OOOOOOOD <KEEP>
Discard Changes

Comnit Changes

[Discard Changes] Z#®#IR L. [Enter] ¥F—%R L CEUDO X =2 —ICEW X7,

Configuration QSR

13.

LPe31000-H6 Mode Mame : 20000090FAEE3918

01: WUN:500000E0 DA334520 <KEEP>
02: WUN:00000000 DOOOOOOO <KEEP>
03: WUN:00000000 6OOOOOOO <KEEP>

: WUN:00000000 0000D00O <KEEP>
: WUN:00000000 00000000 <KEEP>
: WUN:00000000 000OOO00 <KEEP>
: WUN:00000000 000OOO00 <KEEP>
: WWN:00000000 000OOOOO <KEEP>
Discard Changes
Conmit Changes

IO Z2—ICR25EE [ESCIF—%2#WL £,

RILFNRABROZE, AT LERET S SAN X b L =B LUN ICERINTLE TR
THOFCAH— R LT, 13.1.4 BIOS ®BF#ME] ~ [3.1.5 Link Speed MERE] DEREZITL
T, IBIC, OSBLUVTAFNRRREZANDA VR b=k, Y AT LREIERT 23T
DFCH—FT 316 T—FrTNNAZROEE] 2ITVET,

TRTCDHREIHET L7zn. [ESC] ¥ —%:#IR L. Device Manager X Z2—IZREY £7,
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3.1.7. RED R

FZUNRN—T 4 arEBESL.EFEL-RENRE XL T, UEOFIBETHREZRITTEH.
MMB Web-Ul @ [Power Control] EE T [Reset] #&R L. ZYU/S—FT 1> ary2FiEHa8TL
=0y,

1. [Boot] % 7% &R L £ 4, [Boot Maintenance Manager] %#3E3IR L T [Enter] ¥F—%# L.
[Enter] ¥ —%# L £9,
Information @ Configuration J§ Security [

Bootup NumLock State <0ff>

Quiet Boot {Disabled>
Check Controllers Health Status <Enabled>
Boot error handling <Cont inue>

PKE Boot Option Retry <{Disahled>
Boot Removable Hedia <Enabled>

» Boot Maintenance Manager

2. [Reset System] %R L. [Enter] ¥—%2FH L FJ, L/ S—T 1> ayIBREELET,
Information § Configuration J§ Security QLG

» Boot Options
» Boot From File

» Set Tine Out Value

Reset System
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3.2. FC 71—~ @ Legacy BIOS K Z A /Shig# : 11.2.210.13 MRLABEDERE F

g

I~

Z ZTl¥. Legacy BIOS K7 A /\fr#H 11.2.210.13 iRUUIEDREFIEZ B L 7,
Legacy BIOS €— FCREIT 2BDREIL. 2EZ SR IZE L,

321. FCH—FREZ—T 4 U T 1 DiLE

1. UTOXAyvE—UARRINTWABREIC, [Altl+ [E]F 7=z [Ctrl]+ [E] ¥ —%B L ¥4,

Emulex LightPulse FC x86 BIDS, Version 11.2.210.13
opyright (c) 1996-2016 fivago Technologies. All rights reserved.

Press <Alt E»> or <{Ctrl E> to enter Emulex BIDS configuration
itility. Press <s> to skip Emulex BIOS

2. LightPluse BIOS Utility »e8i L £9, BEH L7 74 N—F v 2 Hh— FD FCF— FAHRR
ENBZ0OT, BRELEZWVWFCHR—FZERL[Enter]F—% L £,

This utility displays and saves changes when selected.
You will be prompted to reboot for all changes to take effect.

Emulex FC Ports in the System:

1. LPe31000-M6: Bus:86 Dev:00 Func:00 WWPN: 1000009GFAEE3T18

Enter <Esc> to exit <PageDn> to Next Page
<t~s4> to Highlight, <Enter> to 3elect
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3. BIEETEIRLEFCER—FD Main XZa—AFRraNEd, BIRLE-FCR—FrDXEY T
FL X(Mem Base). 77 —A4 7 = 7 k¥ (Firmware Version). WWPN(Port Name). WWNN(Node
Name) &R RENFE T,

01: LPe31000-M6: Bust#: 86 Dewit: 00 Funch: 00 Boot BIOS: Enahbhled

Mem Base: OOGOEEE0OCE500000 Firmsare Version: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: ZOOOO09OFAEE3918
Link Status: Link Dowm

Enable-Disable Boot from 3AN

Scan for Target Devices
Reset Adapter Defaults
Conf igure Boot Devices
Conf igure Advanced Adapter Parameters

Enter <Esc»> to Previous Menu
{Tr1> to Highlight, <Enter> to Select
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3.2.2. FC 1 — FEREDHIERTL

FCH— FZMEREICRL £T,

RS
TIFHEFEEZO FC H— Rzt anTcunwEzIoc, UTOEERFRETT,
BERET AT TS0,

1. [Emulex LightPlus FC BIOS Utility] X = 2 — /" [Reset Adapter Defaults] = 2R L [Enter] ¥ — %

BLET,
(FXIZ. Lpe31000-M6 Single port FC h— Fflici ) £37)

01: LPe31000-M6: Bus#: 2B Devii: 03 Funci: 00 Boot BIDS: Enabled

Mem Base: GOO00O000A4COREEO Firmsare Version: 11.2.710.13

Port Name: 10000090FAEE394Z2 Node Name: Z00OO@90FAEE3942
Link Status: Link Dowm

Enable-Dizable Boot from SAN

Scan for Target Devices
Reset Adapter Defaults
Conf igure Boot Devices
Conf igure Advanced Adapter Parameters

Enter <Esc?> to Previous Menu
<1ts1> to Highlight, <Enter> to Select
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2. [Reset Adapter Cobfiguration to Defaults? (Y/N): | &FRRranfn, "Y'¥—%2AHLFT,

01: LPe31000-M6: Bus#t: ZB Dewit: 00 Funci: 00 Boot BIOS: Enabled

Mem Base: QOEOO00OA4COO00 Firmsare Uersion: 11.2.210.13

Port Hame: 10000090FAEE394Z2 Node Name: ZOOOOOIOFAEE3I942
Link Status: Link Doun

Reset Adapter Configuration to Defaults? (Y- N):

Enter <Esc> to Previous Menu
{ts1> to Highlight, <Enter> to 3elect

3. UToEmIcERLET,

01: LPe31000-Mo: Bus#: ZB Dewit: 00 FuncH#: 00 Boot BIODS: Disabled

Mem Base: OEOOOEEOA4COEOEOO Firmsare Uersion: 11.2.210.13

Port Hame: 10000090FAEE394Z2 Node NHame: ZOOOOEOIOFAEE3942
Link Status: Link Down

EnablesDisable Boot from 3AN

Scan for Target Devices
Reset Adapter Defaults
Conf igure Boot Devices
Conf igure Advanced Adapter Parameters

Enter <Esc> to Previous Menu
<t-1> to Highlight, <Enter»> to Select

4. BEN—TavarvzBEEEL7EIC. [3.1.4BI0S 0BEML] ITEATLZE L,
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3.2.3. BIOS B

YRAT LEBEFICFC A—FASAN X b L—VFKED LUN Z238@L. T I o TEL L1275
7%, BIOS ZBMICL £9,

1. Main X =2 —#%[Enable/Disable Boot form SAN] % &3R L [Enter] ¥ —%3R L £ ¢,
2. [Boot BIOS]# [Enable] (23R L[Enter] ¥ —%# L 7,

01: LPe31000-M6: Bus#t: 86 Deuvit: 030 Funcl#: 00 Boot BIOS: Enabled

Mem Base: GOO0000ACE500000 Firmsare Uersion: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: Z0OO0OOO90FAEE3918
Link Status: Link Dowm

Boot BIOS is: Enabled

Enable
Disable

Enter <{Esc> to Previous Menu
{T»1> to Highlight, <Enter> to Select

¥Boot BIOS #' [Enabled] (ChA-TWAZ & A#HERL 9,
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3.2.4. Link Speed & Topology DE&TE
Link Speed £ £ U Topology DEREAFEICOWTHBL ET,

B Link Speed DEE X E
THAIEEE D Link Speed (4 Gbps/8 Gbps/16Gbps) (Z& 48 T, Link Speed ZETEHREL £,
¥LPe3200x FC #— FDi5E& 4. (8 Gbps/16 Gbps/32 Gbps) &4l 9,

1. Main X = a1 —7"%[Configure Advance Adapter Parameters] % #iR L [Enter] ¥ —%4F L £ 7,

01: LPe31000-M6: Bus#t: 86 Devit: 00 Funcl#: 00 Boot BIODS: Enahled

Mem Base: OGGOOE00GACE5O00C00 Firmuare Uersion: 11.Z£.210.13

Port Name: 10000C30FAEE3J186 Node Name: ZOOOOEIOFAEE3J18
Link Status: Link Dowm

Enable-Disable Boot from SAN

Scan for Target Devices

Reset Adapter Defaults

Conf igure Boot Devices

Conf igure Advanced Adapter Parameters

Enter <Esc> to Previous Menu
{tr1> to Highlight, <Enter> to Select

pE =1
[Auto Select - Default] (CIZERTEIF LAWTLIEE WL, 25T, EED Link Speed IZERTEIC
LTLESY, EEREICLAEWVGES, ERICERET NNAXPR\ SNV ErHY £,
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2. REM@EIZT[Link Speed Selection] % B4R L [Enter] F —%# L £ 3,

01: LPe31000-Mo: Bust#t: 86 Dewit: 0O Funct: GO Boot BIDS: Enabled

Mem Base: QOOOOEOOCE5S00000 Firmware Version: 11.2.210.13

Port Name: 10000090FAEE3913 Node Name: Z20000090FAEE3918
Link Status: Link Douwm

Change PLOGI Retry Timer
Topology Selection
Enable or Disable Spinup Delay

fiuto Scan Setting

Enable or Disable EDD 3.0

Enable or Disable Start Unit Command
Enable or Dizable Environment Uariable
Enable or Disable Auto Boot Sector
Link Speed Selectiom

Enter <Esc> to Previous Menu
{tr1> to Highlight, <Enter> to Select

3. SAN#EHEE (BEHELTWBEFCRA Yy FEHIZSAN R FL—YEB) (CTEHHE T Link Speed
AZERL[Enter] ¥ =% L £,

01: LPe310600-Mo: Bus#t: 86 Devit: 0O Funci: 0O Boot BIOS: Enabled

Mem Base: OGO000OC0CE500000 Firmware Version: 11.2.210.13

Port Name: 10000090FAEE3J18 Node Name: ZOOOOO90FAEE3918
Link Status: Link Down

Link Speed is: fiuto Select (Default)

Auto Select (Default)

4 Gbrss
8 Gbrss
16 Gbrs

Enter <Esc*> to Previous Menu
<ts4> to Highlight, <Enter> to Select
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4. [ESC]# —x3 T LightPlus BIOS Utility ICR Y £9,

This utility displays and saves changes when selected.
You will be prompted to reboot for all changes to take effect.

Emulex FC Ports in the System:

1. LPed1000-M6: Bus:86 Dev:00® Func:00 WJPN: 10000090FAEEFI18

Enter <Esc> to exit <PageDn> to Next Page
<ts1> to Highlight, <Enter> to Select

5. BEESCIF—%HL ¥, BEBELREZL—T7F 2720 [Y] 23 LBEB T X T LHLEIR
BLET,

Your changes have been sawved.

Reboot the system for all changes to take effect.
REBDOT THE SYSTEM? (Y..N):
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m Topology D TE
Main X = 2 —#»" 5 [Configure Advance Adapter Parameters] % 3%83R L [Enter] ¥ — %3 L £ 7,

JRIEEIC T [Topology Selection] % 8&3R L [Enter] F —%# L £ 3,
SAN i a R LR ICB L 722 EZJIRL [Enter] ¥ —%F L £,
Default ®[Autp Topology:Loop first] h SEEFRHREIZUTA#SB L TS L,

Fabric % : Fabric Point to Point

FC-AL ##: : FC-AL (MC*0JFCF*/CG*, MC*0JFCM*/CN*ICARZRE L H Y FHA)

pE

SAN 7— hZT32TDHFC H— NIZABTEEZ T TLEE L,

B EERE D

I

on

XEEE

FCA— FORBETEZRTICALE T, WABIDOFC XA vF & SANX ML —VEBFT A X7 LA DK

EHETEICTI2HENHY £7,
ETERNUS #3id 2BRICHERRTEICDOWTELCIE. LUTFTD Web A b~ Za7ILA5SEL

TLIEE W,

http://storage-system.fujitsu.com/jp/catalog/manual.html
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3.25. 77— b TFNNA RDETE

SAN 7— 2175 T NARERELEFT, BT NNAZEZZRELHRVTLIEE N,

1. FE. LightPluse BIOS Utility BIEICA Y 7 — k 734 ZAHEEE T WD FC H— k&8I
L. [Enter]¥—%3FL £7,

This utility displays and saves changes when selected.
You will be prompted to reboot for all changes to take effect.

Emvlex FC Ports in the System:

1. LPe31000-M6: Bus:86 Dev:00 Func:00 WAJPN: 10000096FAEE3T18

Enter <Esc> to exit <PageDn> to Next Page
<ts1> to Highlight, <Enter> to Select
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2. Main X = a2 —# %[Configure Boot Devices] Z3E4R L. [Enterl¥—%# L £7,

01: LPe31000-M6: Busti: 86 Dewit: 00 Funci: 00 Boot BIOS: Enabled

Mem Base: QOAOAOEOCISOOEOO Firmsare Version: 11.2.210.13

Port Name: 1000G0G90FAEE3918 Node Name: ZO000C9GFAEE3918
Link Status: Link Dowm

Enable-Disable Boot from SAN

Scan for Target Devices
Reset Adapter Defaults
Conf igure Boot Devices
Conf igure Advanced Adapter Parameters

Enter <Esc> to Previous Menu
<t-s}> to Highlight, <Enter> to Select

3. ®LEfIo [Primary Boot] %3®iR L. [Enter]¥—%#L 7,

01: LPe31000-M6: Bustt: 86 Devit: 00 Funct: 00 Boot BIDS: Enabled

Mem Base: QOOOOEOACESOOC00 Firmsare Version: 11.2.210.13

Port Name: 1000009GFAEE39183 Node Name: Z0000090FAEE3T918
Link Status: Link Dowm

List of Sawved Boot Devices:

Used 100000 PN :500000EQ DA334520
Unused 1 00EOO0 PN : 00000006
. Uhused 10000 WWPN : 00000
. Uhused :0OEO00 PN : 0000006
. Uhused 10000 PN | OOOCEEEE
. Unuszed 1 00EEA0 PN | OO0E0000
. Unused 1 0OEEE0 LLPN | OOOEC006
Unused :OEEEO0 WJPN : OR0AOH06 OOEEEEEER

Primary Boot

28888888

1.
Z.
3
4
5
6
?
g.

<ts1> to Highlight, <Enter> to Select
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4. UToEEFAOEEYRRINETDT, 7— b T/ XREERL[Enter] ¥ -2 L £ 7,

01: LPe31000-M6: Bus#t: 86 Deuvit: 00 Funch#: G0 Boot BIODS: Enahbled

Mem Base: OOOGOOEOAOCE5000600 Firmware Version: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: Z000O00I0FAEE3I918
Link Status: Link Down

Q0. Clear selected boot entryt?t
01. DID:010300 PN :SO0000EQ DA334520 LUN: 6O FUJITSU ETERNUS_DXL

Enter <ESC> to Exit  <PageDn> to NextPage
<t-4> to Highlight, <Enter> to Select

5. Configure Boot Device (2B L7zW\WT /A RIEBHAERRENE T DT, [Enter] F—%FL £7,

01: LPe31000-M6: Bustt: 86 Dewit: 00 Funcit: 00 Boot BIOS: Enabled

Mem Base: OOO00O0C0OAOCESOROMA Firmsare Version: 11.2.210.13

Port Name: 1000GG90FAEE3918 Node Name: ZOOOO@IOFAEE3918
Link Status: Link Dowm

DID: 010300 WJPN:500000E0 DAF34520

Enter two digits of starting LUN (Hex): G0

<ESC> to Prewvious Menu

Enter <ESC> to Exit <PageDn> to NextPage
<1-1> to Highlight, <Enter> to Select
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6. UToBEEFIDESY ., BFELIZWTANA Z%FRL[Enter] 2L £9,

01: LPe31000-M6: Busit: 86 Dewit: GO Funch: G0 Boot BIOS: Enabled

Mem Base: GOO0000ACE500000 Firmsare Uersion: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: Z20000090FAEE3918
Link Status: Link Dowm

DID:010300 WJPN:SO0000EO DA334520

01. BiW LUN:0Q FUJITSU ETERNUS_DXL

Enter <ESC> to Exit <PageDn> to NextPage
<1-s1l> to Highlight, <Enter> to 3Select

7. REM@EIZT[Boot this device via WWPN]% %R L. [Enter]#3B L £,

01: LPe31000-Mo: Bust: 86 Devit: 0O Funch: 00 Boot BIOS: Enabled

Mem Base: OOOEOEOECE500000 Firmsare Version: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: ZO0O0OOO9OFAEE3918
Link 3tatus: Link Down

DID:010300 WJPN:500000EQ DA334520 LUN: 00

Boot this device wia WWPN

Boot this device wia DID

<ESC> to Previous Menu
<ts}> to Highlight, <{Enter> to Select

Enter <ESC> to Exit <PageDn> to NextPage
<ts1> to Highlight, <Enter> to Select
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8. UToEHESIODLEEY., T/ XA BMINET,

01: LPe31000-M6: Busti: 86 Dewit: 00 Funcit: 0O Boot BIOS: Enabled

Mem Base: GO0000EOCE500000 Firmsare Version: 11.Z2.7210.13

Port Name: 10000090FAEE3918 Node Name: Z0000090FAEE3918
Link Status: Link Down

List of Saved Boot Devices:

. Used 1ODEOEE WWPH : 500000E0 DAFI4520
Unused :OEEEOE LWJPN : GOEEEEO0 OEEEEEEE
Unused (0OEEAA PN : GO0OEOO0 COEEEME
Unused 0OEEAA LLWPN : GOEOEOO0 CEEEEME
Lnused 1 QEOOEO  LWPN : GOOOEO00  CEEOEE
Lnused 1EEOOEO  LWPN : GOOOEE0EE  CEEEEE
Unused :0EOE00 LAJPN : 00000000 GOEEEEEC
Unused :OEEEOE PN : GOEEEEE0 OEEEEEEE

Primary Boot

88828888

<t-}> to Highlight, <Enter> to Select

9. [ESC]#F—%# L Main X =2 —I|Z&E Y [Scan for Target Devices] & &R L. [Enter]F —%3F L

£,
1 —

01: LPe31000-MG: Busti: 86 Dewit: 00 Funct: 00 Boot BIOS: Enabled

Mem Base: OGOO000GACE5SOOGO0 Firmware Version: 11.2.210.13

Port Name: 10000090FAEE3918 Node Name: Z0000090FAEE3918
Link Status: Link Down

Enable-Disable Boot from SAN
Scan for Target Devices
Reset Adapter Defaults

Conf igure Boot Devices
Conf igure Advanced Adapter Parameters

Enter <Esc»> to Previous Menu
<t-s}> to Highlight, <Enter> to Select
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10. UTFoBEEAIOEEY ., THAA RO —FRERIPRRINLZOREIITT T,

01: LPe31000-M:: Busti: 86 Devit: 0O Funci: 00 Boot BIDS: Enabled

Mem Base: OOOOOOOACE5S00000 Firmware Version: 11.2.210.13

Port NHame: 10000G9GFAEE3J18 Node Name: ZOOOO09GFAEE3918
Link Status: Link Dowm

Devices Present on This Adapter:

01. DID:010300 WWPN:500000EQ DA334520 LUN:00 FUJITSU ETERNUS_DXL

Enter <Esc> to Previous Menu

11. [ESCl*¥—#%## L Main X =Z2—ICEY £,

HR7%9 % Fibre Device AR TREI NG WEBEIZ. SAN X FL—YDBRE. FC XA v FOEFE. £7-1F
MBEGNEL CAWAEEELDH Y FT O THBEREREZIToTLIEE0,

12. [ESCI¥—%# 2@ L., BEAL—TT DA v E—UhERINEDS [Y] 2 LET, Y ZA
NTBERTFLLNBRELET)

13. TAFRZEHRDOBE, P AT LEZRE TS SAN R FL—VEBO LUN ICEfFENTVDETA
THFC A—RIZH LT, [3.23 BIOS dEM{L] ~ [3.2.4 Link Speed DRE] DEREETVWET,
IBIC.OSBLUOTILF/INRRRTZANDA VR b= Y XTLEBICFERT 2T XTHOFC H—
FT [325 7—FTNARDRE] #1TVET,

TRTCOEBRENRT L7z, [ESCl¥—% 2 B L., ZREEL—TT DA v E—YHER
SN Y] 2 LET, YEANTEERTLLNBERSLET)
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% 4 Z Windows { X h —LIEDEE

700N

Z ZTld SAN 7'— FERIBIZ Windows 24 Y X h— LT 3BOBEICOWTHAL XS,

4.1 Windows Server OS A4 > X k=L

Windows Server OS @A > X F —JLIZDWTIE, OS A v X F—ILFIEEASBIILE W,

4.1.1 Windows Server OS 4 > X k — LD #4

EHHICA VA P—LDIE=HDOBFELET,

FRIREICOVWTEHLCIE, UTESBLTIZEL,

- [PRIMEQUEST 3000 >V —X A~ =27 /L] (CA92344-1655)
[4.3.1 FRRTE] 2SBL TS,

T ILFRZER DB E L. PRIMEQUEST 3000 > —XOAGEEBICERKL WS, A (EHh &
VAN o —7LaNLET, EFEMNICIE. 0S BLPIALFNRIARIANRDA VA M—LHPRETT
BETYVINNRR (FCTr—7L 1 RKOHKDHERR) ICLET,

RIUVFNRRBERINIIRETOS DA VYA F—L%fTr &, EBICA VYA F—ILTEEHA, HOD
LHFEIT, A (Eh&UA) O FC/RR&8ML £,

A12<TIFIRZARTANDA VR k=)L

FERTEITLFNRRARTIANEA VA P=ILLET, A VA= FBIZERTEITILFNIETA
NOBIERGAEZSE L TR I,

413 < ILTF /8 REEDEIR

YT EREEBLES,

OSZz vy hEI YL, =T arOBERZYME, 0S 2B L £J (FC/XRT—TIHY)
SN TWBI5EIE. BERYT %), NEIHDD 2B 2IE, YL F/RTOREZHERE. > v
v b&ZT Y LTHhoARE HDD ZEML £7,
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A ML —VEBEOESGGICETAEE

BEftg 2R ML —2IIGCT, FC A—FOREEENVELIZENH Y £9, FMICOVTIERH
L—YEBOYZaTLESRL TR,

ETERNUS Z 89 2BRCHBEAREICOWVWTEFLCIE, LUTD Web YA bDv =27 LESRL
TS0,

http://storage-system.fujitsu.com/jp/catalog/manual.html
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EHE Linux M A M—IILEFOREE

ZZTIE SAN 7 — FEREBIZ Linux 24 Y A b — LT 3BOBEICOWTHBL ET,

5.1 LinuxOS oA X k—JL

Linux OS DA > X F—JLIZDWTlE, OS A Y R F—LFIBEEZSRB LS W,

5.1.1 Linux 14 > X b — LD ¥

EHHICA VR P—LD=HDOBFELET,

HRREICOWTELL I, UTESBL TS,

- [PRIMEQUEST 3000 >V —X A~ =27 /] (CA92344-1655)
[4.5.1 FaRE] , 4111 FRIFFE] 2SRLTLZS 0,

TILFRZER DB E L, PRIMEQUEST 3000 U —XOAGEEBICERKL WD, A (EHh &
DEDN o —7LENLES, BAERICIE, 0S BLUOTALFRIRSANADAL YR F—LARTT
BETYYINRZ (FCr—71 1 RKDOHDFER) ICLET,

RIVFNRRFEFEINIZREBTOS ZA VR b—LT2E ERBICA VI b—LTEEFHA, HOHL
OFET, FA (A X UA) O FC/RREZYMTL T,

512 WILFNARSANDA VA K=

BRATEYALFRRARSANEL YA =L LET, A YR = LFIBIMERTHVILF IR T A
NOBEGHBAEESRLTTE W,

5.1.3 < IILF/SREEDIEIH

YT EREEBLES,

0SSz vy h&UYL, N=T 4 arDEBREVMER, FIE L.TUMLL FC XRDT—7 L%
BERL. OSZzEEL £9, NEHDD 2EAT 2BIE, YILF XX TORBZHERER, vy bX
7 LTHh AR HDD Z8ML £9,
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FE6E VMware 1 VX b —IILEFFOBEE

LTy 7 bz 7HBEEAL 70— FLTLEEE L,
ESX DA VX F—IFBIZCOWTIE, BYIEA VA=A AT4TEAFE (V7 b7 T7HAE) L
AVAP=IHAFIHEWEEL TLIEE W,

https://jp.fujitsu.com/platform/server/primergy/software/vmware/manual/

VMware TESX AFREEENTWE T —N"EBLRFCH—F, RZABREICOWTIE, £EBA4 R b
— AT A TICERINTVET,
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Fujitsu Server
PRIMEQUEST 3000 >1)—X
SAN 7 —hRIGHEEY=a17 )L
Emulex(Broadcom) 877 A N\—F v R ILH—F iR
(A92344-2329-03

¥ 1T H 2023 £ 05 A

ROTEE ELEKAR

@ KEDODANRIF. HED-OBAHERLGLICERTSHIEAHYET,

@ AEICREBINLT—EAOERISERT 5. E=FDRFHFES IV TOMODIER
DOREFIOVTE, BHIFZOEZTAVFERA,

O BWEHEELET,
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